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1. Introduction

The triaxial stress analysis windows application program (TRIAXI) has been jointly developed
by Maurer Engineering Inc. as part of the DEA-44 project to ‘‘Develop and Evaluate Horizontal Well
Technology’’ and the DEA-67 project to ‘‘Develop and Evaluate Slim-Hole and Coiled-Tubing
Technology.' This program, coded in Visual Basic 1.0, is written for use with IBM or IBM compatible
computers and must run with Microsoft Windows 3.0 or later version.

1.1 MODEL DESCRIPTION

The program calculates the limits of burst and collapse pressure and equivalent stress for the pipe
body. Three pressure limit models are evaluated by the program: 1) triaxial, 2) biaxial, and 3) API.
The program also performs triaxial stress sensitivity analysis for the factors of internal and external
pressure, dogleg, and D/t ratio.

Axial load values from DDRAG (Torque and Drag Model) and internal and external pressure
values from HYDMOD (Hydraulics Model) can be the input of this program to examine equivalent stress
and pressure limits for a specific point in the drill string or coiled-tubing.

1.2 COPYRIGHT

Participants in DEA-44/67 can provide data output from this copyrighted program to third parties
and can duplicate the program and manual for their in-house use, but will not give copies of the program
or manual to third parties.

1.3  DISCLAIMER

No warranty or representation is expressed or implied, with respect to these programs or
documentation, including their quality, performance, merchantability, or fitness for a particular purpose.






2. Theory and Equation

An element of material subjected to stress o,, ay, and o, in three perpendicular directions is said
to be in a state of triaxial stress.

Tubes subjected to axial load and pressure (external and/or internal pressure) are in a triaxial
stress state (Figure 2-1).
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Figure 2-1. Triaxial Stress State
The generally accepted relationship for the effect of axial stress on collapse or burst is based on

the distortion energy theory. A closed triaxial design procedure has been developed by using Von
Mises's and Lame’s equations. This present model does not consider torsional effects.

2.1 TRIAXTAL EQUATIONS

Let E = Elastic modulus (psi)
D, = Pipe OD (in.)
D, = Pipe ID (in.)
I, = Pipe outside radius (in.)
r; = Pipe inside radius (in.)

2-1



g = Yield stress (psi)

F, = Axial force (Ib)
DL = Dogleg (°/100 ft)
Sg = Safety factor
P; = Internal pressure (psi)
P, = External pressure (psi)
The pipe thickness is
t=05 - D, -D) 2-1
The cross area of pipe wall is
A=x-@-D}Hn 2-2)
The average axial stress is
o, =F, /A (2-3)

The maximum bending stress caused by the dogleg is

opL = (x « E « DL + D,)/432000 24)

so that the minimum axial stress becomes

Oamin = 9 ~ 9pL (2-5)
and the maximum axial stress is
Ogmax = % * OpL (2-6)
The allowable maximum axial stress is
os-sf = 0,/ SF @7

and this allowable maximum axial stress is based on zero pressure and zero bending stress. After
converting above stress to force, the allowable maximum axial force is

Fysr=0s-sr * 4 (2-8)

According to Lame’s equation for a thick tube, the hoop stress o}, and the radial stress o, exerted
by the internal and external pressure at the cylinder at radius equals r



2 2 2.2
6. = T B - To P, _ i 7o ®; - PO) (2-9)
d 2 2 2,2 _ 2
ry -7 re(r, - r;)
and
2 2 2 2
Or = ri Pi - ro PO _ ri ra (P! - PO) (2_10)
h 2 2 2.2 2
r, - re(r, - 1)

For most cases, the maximum equivalent stress is at the pipe inside surface. Therefore, the
equation can simplified by letting r = r; and rewriting the equation in pressure and diameter terms so
the above equations become

o, = -P; (2-11)
and
2 2 2
o= %% | p [ 2% |p @-12)
h 2 2| ¢ 7 2| °°
do - di da - di
42
letC=— % L 2-
e 2_t_(d‘;’_t)a\nxqu 2-12 becomes
op=(C-1)pP;,-C-P, (2-13)
Von Mises’s equation is
2 -
20y = [("1 - 09)2 + (09 - 03)2 + {0y - 01)2] (2-14)

where ¢, 0, and ¢ are three principal stresses, and o, is the equivalent stress according to the three principal
stresses. Because the stresses o, 0}, and o, are three principal stresses they can be inserted into Von Mises’s
equation. If the bending stress is disregarded, Eq. 2-14 becomes

2oy = [(o'a - ah)z + (o - ar)z + (0, - 4)2] 2-15)
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Combine Egs. 2-11 and 2-13 into Eq. 2-15 and rearrange the terms in the equation.

b %+ 2CR - Pix| -39, - 60,B - 3B} + 4} @-16
o 2C

or

Cao, - 20, +2C*P, - CP, iﬁ 3C%0, - 6C%g,P, - 3C2P2 4 4(C?-C + 1)} @-17)
2(C2-Cc+1)

i

In Eq. 2-16, if o+, is replaced with o5 g (Eq. 2-7), the solution P is the collapse pressure using the
triaxial method.

Mathematically, there are two solutions for P, from Eq. 2-16 (for positive and negative square roots),
but in practicality only positive real number(s) represent the collapse pressure P ,. There can be one, two, or
no solution(s) for the collapse pressure design. When bending stress is considered, which is caused by the
wellbore dogleg, o, in Eq. 2-16 is replaced with o, (Eq. 2-5) and o, (Eq. 2-6). This results in the
solution(s) for collapse pressure design with minimum and maximum bending stress effects,

Note, when g, is replaced by 0., and 6,1, both 6, and o, .. can have the positive square root
solution. If this happens, the program uses the smaller value of the two positive square root solutions as the
upper boundary of collapse design. In the same way, the program will take the larger value from the two
negative square root solutions as the lower pressure boundary of the collapse design.

Operating Pressure
4 positive square root solutions

max. operating pressure

negative square root
solution

min. operating pressure

— 44—+ Axial Stress

N,

minimum axial stress
average axial stress
maximum axial stress

Figure 2-2. Bending Stress Effects on Burst Pressure Design
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Buckling phenomenon, especially helical buckling, will cause bending stress. Buckling stress effects
are not considered in this version.

In Eq. 2-17, if oy is replaced with o5 gp (Eq. 2-7), and o, is replaced with o,., (Eq. 2-5), 0.
(Eq. 2-6), the outcome is the burst design pressure for the triaxial stress method.

Figure 2-2 shows the relation between bending stress and operating pressure for the burst design.

2.2 BIAXTAL EQUATION

To disregard the internal pressure on collapse pressure design, let P; = O and Eq. 2-16 is simplified.

2 2
o i\ﬁr,, - 40> - o%) (2-18)
0 =3C

If o, and oy, are replaced by o, i, (Eq. 2-5), 64pax (EQ. 2-6), and o g (Eq. 2-7), Eq. 2-18 produces
the collapse design pressure for biaxial stress analysis.

Let P, = O in Eq. 2-17 and it becomes

p . €~ Do, ty-3ctl 4t -Can 2-19)
' 2(C2-C+ 1)

The above equation is the burst design pressure for biaxial stress analysis.
where

C - P (2-20)

2.3 APT EQUATION

API Bulletin, 5C3, 1989, *‘Formulas and Calculations For Casing, Tubing, Drill Pipe and Line Pipe
Properties™ (see for details) lists all API standard equations for axial stress limits, burst pressure limits, and
four collapse pressure range limits.



3. Program Installation

3.1 BEFORE INSTALLING

3.1.1 Check the Hardware and Svstem Requirements
TRIAXI1 is written in Visual Basic®. It runs in either standard or enhanced mode of Microsoft
Windows 3.0 or higher. The basic requirements are:

Any IBM-compatible machine built on the 80286 processor or higher.
Hard disk.

Mouse.

CGA, EGA, VGA, Hercules, or compatible display.

MS-DOS version 3.1 or higher.

Windows version 3.0 or higher in standard or enhanced mode.

An 80486 processor and VGA display is recommended.

For assistance with the installation or use of TRIAX1 contact;

Lee Chu or Russell Hall
Maurer Engineering Inc.
2916 West T.C. Jester Boulevard
Houston, Texas 77018-7098 U.S.A.
Telephone: (713) 683-8227 Fax: (713) 683-6418
Telex; 216556

3.1.2 Check the Program Disk
The program disk is a 3%% inch, 1.44 MB disk containing thirteen files. These thirteen files are

as follows;

SETUPKIT.DL_
VBRUNI100.DL _
VER.DL._
GSWDLL.DLL
GSW.EXE
SETUP.EXE
SETUP1.EXE
TRIAX1.EXE
SETUP.LST
GRAPH.VBX
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We recommend that all .VBX and .DLL files, that have the potential to be used by other DEA-
44/67 Windows application, be installed in your Microsoft Windows\SYSTEM subdirectory. This applies to
all the .VBXs and .DLLs included here. The TRIAXI executable (TRIAX1.EXE) file should be placed in
its own directory (default ‘‘C\TRIAX1""). All these procedures will be done by a simple setup command
explained in Section 3.2.

In order o run TRIAX], the user must install all the files into the appropriate directory on the
hard disk. Please see Section 3.2 to setup TRIAX].

It is recommended that the original diskette be kept as a backup, and that working diskettes
be made from it.

3.1.3 Backup Disk
It is advisable to make several backup copies of the program disk and place each in a
different storage location. This will minimize the probability of all disks developing operational problems
at the same time.

The user can use the COPY or DISKCOPY command in DOS, or the COPY DISKETTE
on the disk menu in the File Manager in Windows.

3.2 INSTALLING TRIAX1

The following procedure will install TRIAX1 from the floppy drive onto working subdirectories
of the hard disk (i.e., copy from A: drive onto C: drive subdirectory TRIAX1 and
WINDOWS\SYSTEM).

1. Start Windows by typing *‘WIN'’ <ENTER> at the DOS prompt.

2. Insert the program disk in drive B:\.

3. In the File Manager of Windows, choose [Run] from the [File] mem. Type B:\setup and press Enter.
4. Follow the on-screen instructions.

This is all the user needs to setup TRIAX1. After setup, there will be a new Program Manager
Group (DEA APPLICATION GROUP) which contains the icon (ax,.,_) for TRIAX1 as shown in
Figure 3-1.



=] : - Pragram Manager 2l el By
Eile Qptions \Yindow Help

= Microsoft Visual Basic HEZ
o =
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Figure 3-1. DEA APPLICATION GROUP and ‘‘TRIAX1"' Icon

3.3 STARTING TRIAX1

3.3.1 Start TRIAX1 from Group Window
To run TRIAX] from the Group Window, the user simply double-clicks the **TRIAX1"’
icon, or when the icon is focused, press < ENTER>.

3.3.2 Use Commangd-Line Option from Windows
In the Program Manager, choose [Run] from the [File] menu. Then type
CATRIAXINTRIAX1.EXE <ENTER>.

3.4 ALTERNATIVE SETUP
When the SETUP procedure described before fails, follow these steps to install the program:
I. Create a subdirectory on drive C: C:\TRIAXI.
2. Insert the source disk in drive B: (or A:).

3. Type: CD\TRIAX! <ENTER>.
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10.

11.

12.

13.

14.

At prompt C:\TRIAX1, type:
Copy B:\TRIAX1.EXE <ENTER>

Type: CD\WINDOWS <ENTER>.

At prompt C:\WINDOWS >, type:
Copy B:\VBRUN100.DL_ VBRUN100.DLL <ENTER>.

Type: CD\WINDOWS\SYSTEM <ENTER>.

At prompt C:\WINDOWS\SYSTEM >, type:
Copy B:\*.DLL <ENTER>

Copy B:\\GSW.EXE <ENTER>

Copy B:\*.VBX <ENTER>.

Type: CD.. <ENTER> then key in “‘WIN" <ENTER> 1o start Windows 3.0 or later

version.

Click menu ‘‘File’’ under ‘“PROGRAM MANAGER,” select item [New...] click on
[PROGRAM GROUP] option, then [OK] button,

Key in “‘DEA APPLICATION GROUP"’ after label ‘‘Description:,”’ then key in ‘‘DEAMEI"’
after “*‘Group File:,"" then click on [OK] button. A group window with the caption of ‘‘DEA
APPLICATION GROUP" appears.

Click on menu [File] again, Select [NEW...] click on ““PROGRAM ITEM"’ option, then,
[OK] button.

Key in ‘“TRIAX1"’ after label *‘Description,’’ key in ‘“‘C:\TRIAX1\TRIAX1.EXE'"’ after label
“COMMAND LINE,"” then click on [OK] button. The TRIAX]1 icon appears.

Double-click the icon to start the program.
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4. Running TRIAX1

4.1 INTRODUCTORY REMARKS

TRIAX] runs in a windows environment. It is assumed that the user is familiar with windows,
and the user's computer is equipped with Windows 3.0 or later version.

Some elements and terminology of windows are reviewed here:

4.1.1 Terminol | f Win
Figure 4-1 shows the Sensitivity Window (see Section 4.2.2 for details).

— Minimize Box

— Contrel Box I_'I‘itle Bar —_ Maximize Bex
=| Sensitivity Analysic [v]e. or
File Graph gSeting Help Restore Box
Print
g:ite ack «  Pull Down Menu
Menu Sclections
Figure 4-1. Title Bar in Window
1. The Title Bar
The title bar serves two functions: one is to display the name of the current
window and the other is to indicate which window is active, The active window
is the one whose title bar is in color. (On monochrome monitors, the difference
is shown by the intensity of the title bar). The user can make a window active by
clicking anywhere within its border.
2. The Control Boxes _
At the left side of the title bar is the control box. It has two functions. First, it
can display the CONTROL menu, which enables the user to control the window size
using the keyboard. Second, double-clicking the control box will end the current
program.
During execution of TRIAX], the control boxes are not needed. The program will
run according to its own flow chart.
3. Minimize and Maximize Boxes

At the right side of the title bar are the MINIMIZE and MAXIMIZE boxes. The box
with the up arrow is the MAXIMIZE box. The box with the down arrow is the
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MINIMIZE box. If a window has already been maximized, the MAXIMIZE box
changes to a RESTORE box with both up and down arrows, as shown in Figure 4-1.

* Clicking on the MINIMIZE box will reduce the window to the size of an icon.
The window's name in the title bar appears below the icon. To restore a
window from an icon, double-click on the icon.

» Clicking on the MAXIMIZE box will make the window take up the total working area.

® Clicking on the RESTORE box will make the window take up a portion of the
total working area, which is determined by how the user magually sizes the
window.

4. Text Boxes
TEXT boxes can display the information that the user enters. Sometimes there will

be text already typed in for the user. The user can use arrow keys to edit the
existing text. Figure 4-2 shows a typical text box.

General Input : Tri-Axial Burst Input :

Elastic Modulus (30000000 | Esternal Pressure

Pipe 0.D. [7 —' Tn-Axial Collapse Input :

Pipe 1.D. |§.92 ‘ Internal Pressure
Yield Stress | 110000 J

Figure 4-2. Text Boxes for Data Input and Display

5. Command Buttons
A COMMAND button performs a task when the user chooses it, either by clicking
the button or pressing a key. The caption of command buttons that are used in
this program are: [OK], [CIRCULATING], [GRAPH], [GO BACK], [END], etc.

Using the [TAB] key or mouse point can switch the focus around the text boxes and
command buttons within a window.

OK
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6. Spin Button
The spin button is used with text boxes to increment and decrement the number
inside the text boxes, Click the right arrow to increment the value and click the
left arrow to decrement the value.

el | P
1000

7. Getting Into Focus

Using the [TAB] key or by moving the mouse pointer, the user can move the
cursor around the TEXT BOXES, COMMAND BUTTONS, and SPIN BUTTONS, efc.

When the cursor stays on one element, for example the TEXT BOX, getting into
focus. When the COMMAND BOX is getting into focus, the box will have a thick
border, if you press <ENTER >, the command will be executed.

4.2 OVERVIEW

There are three major windows in TRIAX]:

1. Tubing Stress Analysis

2. Stress and Limited Pressure Graph

3. Sensitivity Analysis.

These three windows appear on screen in a series. The user can change the input data through
each window, but the input data in each window will affect data in the other windows.

If using a color monitor, the input data text boxes always have a green background, and the output
data text boxes always have a blue background.
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4.3 GETTING STARTED

1. Call up Windows and select *'DEA APPLICATION GROUP’’ as the active window, as shown
in Figure 4-3.

= Microsoft Visua! Basic [~]=

% o

Microsof MS-D0S File M anager
Visual Basic Prompl

=] . DEAAPPLICATIONGROUP .- - |v]=
Tridx) Tortuosiy

Figure 4-3. DEA Application Group (MEI) and TRIAX1 Icon
2. This window may contain more than one icon. Double-click on the TRIAX1 icon.

3. When the Disclaimer screen (Figure 4-4) appears, click on the [OK] button. This opens the
**Tubing Stress Analysis ' window (Figure 4-5).

-=| Disclaimer

Tri-Axial Stress Analysis Program {TRIAX1 v1.0)
DEA-44/DEA-67
By
Maurer Engineering Inc.

This copyrighted 1993 confidential report and computer
programare for the sole use of Participants on the
Drilling EngineeringAssociation DEA-44 andfor DEA-67
Projects and their affiliates,and are not to be disclosed
to other parties. Data output fromthe program can be
disclosed to the third parties. Participantsand their
sffiliates are free to make copies of this report
andprogram for their in-house use only,

Maurer Engineering Inc. makes no warranty or
representation.either expressed or implied, with respect
to the program erdocumentation, including their quality,
performance. mercha-nability, or fitness for a particular
purpose.

o]

Figure 44. Disclaimer Window
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"’1 Tubing Stress Analysis _| - | s
Help

Tubing Siress Analysis

General Input : Tei-Axial Buist Input :

Elactic Modulus (psi) (20000000 External Piatzure [psi) !Cdcuiilihﬁ
Pipe 0.D. (in) I:l Tri-Axial Collapse input :

Pipe 1.D. fin) [5.32 Intemal P (pail ' Graph
Yield Stioes [pai) a

Axial Force [Ib]

Dogleg dog/1001] 5] End

Sally Faclos
General Dutput TAl-Axal Oper. Pres.  Bl-Axial Oper. Pres. APl
Thicknos P59 ] Bustlimis. (75 |[(0127 | P_ | L L
Cioss Area Collapse Limits [0 — |[13\2 | P |B53_ ] 7T |
Bending Stiess Minimum  Madmun  Minimum M aximum
Min_ Axiol Suess

Avp. Axial Strezs  [1G000D Allow. Max. Axal Stress [T10000
Max, Axal Suess Allow. Max. Axial Force

Figure 4-5. Tubing Stress Analysis Window

4.4 TUBING STRESS ANALYSIS

This window includes the default data. Note that the ‘“External Pressure’’ and ‘“‘Internal
Pressure’’ inputs are for the triaxial burst and the triaxial collapse calculations only.

To change any of the input data, click on the desired text box. If you are not using a mouse, use
the [TAB] key to move from one box to another and use the arrow keys to move within a field. When
data has been input, click the [Calculating] button, the results will print in the lower part of the screen
and the [Graph] command button will show on the screen also. All output data have a blue background.
To end the program and return to the MS Window, click the [End] button.

Following are equation numbers shown in Chapter 2 relating to each output data:

Thickness -  Equation 2-1
Cross Area -~ Equation 2-2
Average Axial Stress - Equation 2-3
Bending Stress - Equation 2-4
Minimum Axial Stress - Equation 2-5
Maximum Axial Stress -  Equation 2-6
Allowable Maximum Axial Stress -  Equation 2-7
Allowable Maximum Axial Force -  Equation 2-8
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Equation 2-17

Triaxial Minimum Burst Pressure

Triaxial Maximum Burst Pressure - Equation 2-17
Triaxial Minimum Collapse Pressure -  Equation 2-16
Triaxial Maximum Collapse Pressure -  Equation 2-16
Biaxial Minimum Burst Pressure -  Equation 2-19
Biaxial Maximum Burst Pressure - Equation 2-19
Biaxial Minimum Collapse Pressure -  Equation 2-18
Biaxial Maximum Collapse Pressure -  Equation 2-18

4.5 STRESS AND LIMITED PRESSURE GRAPH

In the ‘‘Tubing Stress Analysis™ window, the [Graph] command button will appear on the screen
after calculating. Click the [Graph] button, then the *‘Stress and Limited Pressure Graph' window
shows on the screen (Figure 4-6).

=| Siress and Limited Pregsure Graph I~]s
_ Minimum Yield Pressure
Pieenue (kpsi) Bi-axial and API Graph
BURST 20 — "

. /‘/L\

8L 4 qioput Data:
|l | + JExternal Pres. p1i [100p.
——Bi-Asial ! | Pres. psi
— AP . 3
N ] ] Avial Force b

8 | 4 J
12 ] ] ‘Sen:iliv;! L Help I
COLLAPSE 20

-200 -160 -120 -80 40 © 40 80 120 160 200 Axial Stress (kpsi)

Cuesos Cooedinate [pai] - TriAnial Opes. Pres [psil  BiAxiad Dper. Pros. [pai]l AP [pii]

Axial Strass Huorst Limit E—_H'I—!ﬁm r—_]ﬁlﬂTlli‘ WT
Prosaure Collapea Linit [ _|[123045 ] [ | f2077€ | fa0i7E |

Minimum Mazimum Minimum M aximum

Figure 4-6. Stress and Limited Pressure Graph Window

On the right-hand side of the screen there are three imput text boxes. The top two bozxes,
‘‘External Pressure’’ (for burst) and ‘‘Internal Pressure’’ (for collapse) are for triaxial stress calculation
only. The last input box, ‘*Axial Force'’ relates to the cursor location.



This program converts ‘‘Axial Force’ to “*Axial Stress’’ and makes this axial stress the cursor’s
X-coordinate. Move the cursor into the *‘Biaxial and API Graph’® area and a black-cross cursor will
appear in the graph. While moving the cursor within the graph, the data in the cursor coordinate boxes
‘‘Axial Stress’’ and ‘‘Pressure,’’ which are located on the left bottom of the screen, are updated. Only
the axial stress affects the burst pressure limits and collapse pressure limits. The pressure text box
reflects only the cursor’s Y-coordinate. If there is any solution, the value will print on screen;
otherwise, it shows *‘N/A"’ in the output box. When the tension or compression force is too large, there
is not a solution. The pressure limit equations used here are the same in the ‘‘Tubing Stress Analysis’’
window (Figure 4-5). If there are solutions, the red circles (for biaxial) and/or white circles (for
triaxial) show on the screen to indicate the minimum yield pressure at current axial stress (i.e.,
cursor’s X-coordinate), If both biaxial and triaxial have the same solution, the circle’s color will
be black.

Note: If the mouse is moved too fast (this depends upon the capability of the user’s PC), the circle
drawing may not have enough time o respond.

4.6 SENSITIVITY ANALYSIS

Click the [Sensitivity] button. This will load the *‘Sensitivity Analysis’> window. This is the only
window that the program outputs the results to the printer.

There are five graphs shown:

1. “‘Internal Pressure Sensitivity Analysis’’

2. ‘“‘External Pressure Sensitivity Analysis™

3. Both ‘“‘Internal Pressure Sensitivity Analysis and External Pressure Sensitivity Analysis”
4. ‘‘Dogleg Sensitivity Analysis”’

5. ‘“‘Diameter and thickness (D/t) Ratio Sensitivity Analysis."’

Figure 4-7 shows the pull-down [Graph] menu.

B e U - USenghtvity Analyals < v L l=ls
Elie :Graph  Setting Help
» Cascade S
Tile
All

Internal Pregsure
External Presgure
Both Int. and Ext,
Dogleg

Ratia Dt

Table

Figure 4-7. Pull Down (Graph) Menu in Sensitivity Analysis
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The user can examine each graph by clicking the name of the graph. All five graphs and the data
table are shown by clicking [All] (Figure 4-8). The graph and tble are contained inside six sub-
windows. To enlarge the graph size:

L.

3.

4.

Activate the sub-window by clicking any where inside the window (the title bar of active sub-
window will be in color).

When the mouse cursor is moved to the boundary of the sub-windows, the cursor becomes a
double arrow (Figure 4-9).

Hold left button of mouse, then drag the boundary to the size you want.

For full screen graph, click the maximize box in the top-right corner of the sub-window.

NOTE: To change the graph size on the screen is important, because the printed graph size
depends on the graph size shown on the screen.

=] L Senshivity Analysis - .. o B
Eile Graph Setting Help
= [Int, Presaure Anstysis |« [~ Ext. Pressure Anstysis Int. & Ext. Pressure Analysis
Internal Presswe Sensivit)' External Prassurs Semsitivity Internal and External Presas
- - Serwitivity
L] Hobbbd / /
L
Ty e Mo a0 / T L
- / twel} ::;' 100808
g ot
.- 1 sases
i we Gher TMe Time - Tos NN G Gt e T
el pre— ) Retatiosl It svsala i) T & 2o prassera fpoi]
Dogleg Analysis Dt Ratio Analysis Calculated Data
Dogiag. Banding Stres Sansivity DA Ratio Sensitivity LP:L.PHES Equivalent | Intemnal [+
ion Stiess pai |Prex. pri
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Figure 4-8. All Sensitivity Graphs and Table
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Figure 4-9. Using Mouse to Change Window Size

The “‘calculated data table’’ will show data for the active sub-window’s graph. To send results
to the printer:

1.  Activate the desired sub-window
2. Pull down the (File] menu
3. Click [Prin]

To leave Sensitivity Window:

1. Pull down the [File] mems.
2. Click [Go Back] to go back to ‘*Stress and Limited Pressure Graph’’ window.
3. Click [Exit] to return to the MS windows,

Figure 4-1 shows the pull-down [File] menu.
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4,7 SETTING SENSITIVITY DATA

Click [Setting] and [Setting Range and Data] on the menu bar, a sub-window of data settings will
appear (Figure 4-10).
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Figure 4-10. Data Setting Window for Sensitivity Analysis

The user can set up two groups of data;

1. Graphic range for each sensitivity graph’s X-coordinate, on the top-side of the Setting
window. -
2. Basic calculating data, on the bottom-side of the Setting window.

The setting of both groups will affect the graphic output. Each sensitivity graph uses only part of
the set data. For example, the [BASIC CALCULATING DATA] group:

1. [INTERNAL PRESSURE] sensitivity graph uses the data: axial stress, external pressure, pipe
OD, and pipe thickness.

2. [EXTERNAL PRESSURE] sensitivity graph uses the data: axial stress, internal pressure, pipe
OD and pipe thickness.

3. [INTERNAL AND EXTERNAL PRESSURE] sensitivity graph uses the data: axial stress,
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4. [DOGLEG] sensitivity graph uses all data in the group.

5. [D/t RATIO] sensitivity graph uses the data: axial stress, internal pressure, and external
pressure.

6. The X-axial data range for each graph depends on the ‘‘lower boundary” value and ‘‘upper
boundary’’ value underneath each graph's title in the Setting window.

Each time the data is changed, the user must click the [OK] button to redraw the graph with
current seftings.
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